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Introduction 
Negative Deductions Enhancement for Microsoft Dynamics GP is designed to provide functionality that will 

allow the system to process negative deduction transactions during payroll processing, which otherwise would 

be disallowed by Dynamics GP.  The deductions may appear on a check with wages (thereby affecting the 

wage amount) or may appear on a check with no wages (resulting in a net positive check). This is useful for 

situations such as 

1) When a reimbursement is due to be remitted to an employee  

2) When an employee deduction (eg…health insurance) has been over-withheld due to  a termination or 

other mid pay period event 

3) When payroll wishes to make an adjustment to a previous deduction amount on a paycheck without 

modifying deduction maintenance records. 

The Product builds upon Microsoft’s recommended procedure for processing negative deductions, which 

involves a negative deduction conversion during payroll processing and the creation of a manual check during 

posting.  The negative deduction conversion is a process whereby the system removes the negative deduction 

and replaces it with a positive pay code transaction of the same amount.  The manual check adjustment acts 

as the reversing entry for the converted deduction and re-balances the accounts.   This product saves time for 

payroll personnel by automating the process of manual check adjustment creation and posting.  It also 

prevents the re-training of staff by allowing them to enter deductions as they normally would, but having the 

system convert them automatically transparent to the user. 

Negative Deduction Setup 
Negative Deduction Setup gives the user the ability to set general configuration options including the behavior 

of adjustment posting and the ability of the user to override default mappings.  

Deduction Mapping Setup is where the user can define which pay codes will be used during the deduction-to- 

pay code conversion process.   

Negative Deduction Entry 
The user can create negative deductions in transaction entry or import negative deduction transactions using 

third party tools or separate functionality.  Negative Deductions Enhancement allows the user to designate a 

transaction batch as a negative batch. If so, the batch will process all negative deduction records therein, by 

converting them to a pay code (“business expense” pay type) during payroll processing. Negative deductions 

can also be processed in a normal batch alongside other transactions. 

When a user modifies or creates a negative deduction transaction, the system will prompt with confirmation 

and may also prompt the user for conversion information depending on setup options.  
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Negative Deduction Processing / Reporting 
Negative deductions are processed during the payroll build in one of two ways.  

1) The system will process a negative deduction according to current functionality (eg... a transaction required, 

negative, fixed amount deduction in payroll transaction entry)  

2) The system will convert the negative deduction to a pay code transaction  

Payroll build checks processing then occurs as normal, and the system will present a report (see below) of the 

negative deductions that were included in the build.  The build completes and the user continues processing 

payroll by calculating and printing checks.  Depending on setup options and conversions during the build, the 

system will include negative deductions on the checks or pay codes representing negative deductions. Then, at 

posting, the system will create manual check adjustment records for converted negative deductions.  The 

manual check adjustment will reverse the pay code transaction that appeared on the earnings statement (or 

paycheck) and create negative deduction amounts for the manual check adjustment.  The user can then post 

the manual adjustment batch or the system will auto post the batch depending on setup options. 

Just prior to the Build report, the system provides a Negative Deduction Transaction Report (configurable via 

posting settings) detailing ALL negative deductions regardless of the batch type (normal or negative) and 

regardless if a negative deduction is to be processed normally or as a converted pay code. 
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Quick Setup Steps 
The following are the quick reference steps necessary to set up the Negative Deductions Enhancement product 

and begin using the features.  

Negative Deduction Setup 

If business rules dictate that the user responsible for processing payroll is also authorized to change pay code 

mappings for negative deduction (eg…user is also the payroll administrator) then check the box “Allow Pay 

Code Mapping Override” This will enable the user to change what pay codes the negative deduction can map 

to during the entry of a negative deduction transaction. 

Checking “Auto Post Adjustment” will cause the system to post all manual adjustments reversing entries 

automatically after the payroll process is completed and the pay run is posted.  It is recommended not to check 

this box if you wish to audit or verify the adjustments. 

Deduction Mapping Setup 

In order to process negative deductions by using the conversion to pay code process, a pay code mapping is 

required. If the system is configured to allow designation of a pay code during transaction entry then you can 

specify one at that time.  If not then you must set up pay code mapping defaults.  Enter a pay code or select 

one from the lookup.   Note that the available pay codes are limited to those of type business expense not 

marked to report as wages.  Then insert one or more deduction codes that will map to the pay code during the 

conversion process.  More than one deduction can map to a pay code but any given deduction can only be 

mapped to .a single pay code.  The system makes a window level report available, designed to provide the user 

with a list of pay codes with their respective deduction mappings.   
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Installation Overview  
This section will discuss the prerequisites, list the files installed and go through the install process.  

Prerequisite 
Negative Deductions Enhancement requires the use of the Microsoft Dynamics GP Payroll module. This 

document will assume Payroll is installed and registered.  

Install 

Notes  

Prior to installing complete the steps: 

 Confirm all users are logged out of Microsoft Dynamics GP 

 Complete all payroll runs and validate no payroll runs are in process 

 Make a backup of the Company and Dynamics databases 

 

Server/Client 
To install Negative Deductions Enhancement downloaded the exe file from our website.  Once the files have 

been downloaded, you can run them on the Server and/or Client Installations.   The product will need to be 

installed on all machines that process payroll.  If you will send with using Microsoft Outlook then download 

the Outlook Setup.exe in addition to the Integrity GP 2015 or 2016 Setup.exe 

Complete the steps required at the Server and/or Client level to create the necessary Microsoft SQL Server® 

Components.  Creating the Microsoft SQL Server Components needs to be performed on a single computer, 

typically the server. 

1. Right click Integrity Data GP2015 or 2016 Setup.exe file and select “Run as Administrator”.  If you do 

not see this option, hold the shift key down and right click. 

2. Complete the steps in the wizard 

http://www.integrity-data.com/hrp/product-download-form/0310360942-2/
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3. Verify the GP directory is correct if it is not select Change 



10 

 

4. Select Custom to choose to install only the specific products you purchased.   

5. Select Activation Components to only install activation manager files.  This option will not install 

products and it is typically run only to fix an error with activation manager. 

6. Select All Components to install all Integrity Data products.  The products you did not purchase will 

register with a 30-day trial period.   
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If you are upgrading you will be prompted to uninstall the older version, select “y”. If you have multiple 

products, it will uninstall all products. 

 

7. Select the product(s) to install, if installing multiple products, select all that need to be installed. 
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8. Launch Microsoft Dynamics GP 2015 or 2016. 

9. If prompted to include new code, choose yes. 

10. Login as the ‘system administrator’ for each company to create the SQL Server components. 

11. The system will auto activate the products you have purchased if you have access to the internet on 

the machine.  If you receive a message Activation Manager failed contact support@integrity-data.com 

and include a screenshot of the Activation Manager window to receive manual keys. 

 

  

BEST PRACTICES 

Install is not a requirement 
on the Server; however it is 

recommended. 

Install updated version on 
previously installed Client 

machines. 
 

 

mailto:support@integrity-data.com
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Manual Install 

If the user encounters errors during the installation, complete the following steps to manually install Negative 

Deductions Enhancement: 

1. Contact support@integrity-data.com to receive the manual install files for the product(s). 

2. Copy and paste the files into the appropriate locations. 

GP Folder (C:\Program Files\Microsoft Dynamics\GP2015) or (C:\Program Files\Microsoft 

Dynamics\GP2016) 

 NDE7224.cnk  

 Application.IntegrityDataActivation.dll  

 Integrity.Registration.Constructor.dll  

 IDA6537.cnk 

 Integrity.Registration.Addin.dll 

Documentation Folder (C:\Program Files\Microsoft Dynamics\GP2015\Documentation) or 

(C:\Program Files\Microsoft Dynamics\GP2016\Documentation) 

 Negative Deductions Enhancement User Guide.pdf  

 

3. Edit the Dynamics.exe.config 

a. Navigate to the GP folder (C:\Program Files\Microsoft Dynamics\GP2015) 

a. Backup the Dynamics.exe.config by making a copy and saving the copy **Important** 

b. Open Dynamics.exe.config in Notepad 

c. Find the <addin> and under <Dynamics> copy and paste the following: 

<addin name="IDKeyManagerAddIn" 

type="Integrity.Registration.Addin.GPAddIn,Integrity.Registration.Addin,Version=14.0.5.202

97,Culture=neutral,PublicKeyToken=b7ed37edf026e3bc"/> 

d. Under <DynamicsGPweb> copy and paste the following: 

<addin name="IDKeyManagerAddIn" 

type="Integrity.Registration.Addin.GPAddIn,Integrity.Registration.Addin,Version=14.0.5.202

97,Culture=neutral,PublicKeyToken=b7ed37edf026e3bc"/> 

mailto:support@integrity-data.com


15 

 

4. Launch Microsoft Dynamics GP. 

5. Login as the ‘system administrator’ for each company to create the SQL Server components. 

Files Installed  

GP Folder (C:\Program Files\Microsoft Dynamics\GP2015) or (C:\Program Files\Microsoft 

Dynamics\GP2016) 

 NDE7224.cnk or NDE7224.dic 

 Application.IntegrityDataActivation.dll  

 Integrity.Registration.Constructor.dll  

 IDA6537.cnk  

 Integrity.Registration.Addin.dll 

Documentation Folder (C:\Program Files\Microsoft Dynamics\GP2015\Documentation) or 

(C:\Program Files\Microsoft Dynamics\GP2016\Documentation) 

 Negative Deductions Enhancement User Guide.pdf  
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Registration 
The system will automatically activate the product during the log in process.  If the activation was successful, 

the user will not receive any messages. However, if the activation process was unsuccessful the user will 

receive a message.  If the activation process fails the user will need to open the Activation Manager window to 

activation the product. 

Activation Manager Window 
Microsoft Dynamics GP > Tools > Setup > System Activation Manager 

 

The Site Name defaults from the session information on the About Microsoft Dynamics GP window. 

From the Product drop-down list the user may select the product they wish to activate and review product 

information.  Once the product is selected the following fields will display: 

 Installed Version – Current version number installed 

 Trial Expiration Date – Date of the trial expiration period typically 15 days, if applicable 

 Activation Status – Current status of the product 

o Permanent –Product has been purchased 

o Trial – Product has been issued a trial period 

o Deactivated – Product has been deactivated 

 Current Employees – This count defaults from the session information on the About Microsoft 

Dynamics GP window.  The count does not include inactive employees or employees in a Test or 

Historical company.  If the current employee count is incorrect validate Test or Historical companies 

are named correctly.   
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 Employees Allowed – The number of employees allowed before the product will be inactivated.  If the 

Current Employees exceeds the Employees Allowed the system will deactivate the product.   

The scrolling window contains a list of all companies; by default the product is active for all companies.  If the 

user would like to inactivate a company unmark the company checkbox.   

The Auto Activation option may be selected if the user receives a message at log in stating the product is not 

activated.  When the user selects the Auto Activation option the system will attempt to automatically activate 

the product.  Once the Auto Activation process is complete the system will display the Activation Messages.  

For a detailed list of activation messages see the Activation Manager Messages section. 

The Manual Activation option is used to manually enter a Token.  The user would only manually enter a token 

if they were sent a token by Integrity Data. 

Select the OK button to close the window.   

Test and/or Historical Companies 
Registration will not count the active employees in Test or Historical company databases if the Company 

Name is named correctly, specifically at the end of the Company Name the user must append the following: 

“<TEST>” or “<HISTORICAL>”. See examples below: 

 Dextordinary, Inc. <TEST> 

 Dextordinary, Inc. <HISTORICAL> 

To access and modify the Company Name open the Company Setup window via Microsoft Dynamics GP > 

Tools > Setup > Company > Company when logged into the Test or Historical Company that needs modified. 

Version Information 
To obtain the latest Negative Deductions Enhancement version information, visit our website. 

Within Microsoft Dynamics GP verify the version for Negative Deductions Enhancement by selecting the Help 

Button, select About Microsoft Dynamics GP and then select the Options button. Click OK until the Negative 

Deductions Enhancement window appears. 

http://www.integrity-data.com/hrp/product-releases/
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Security Settings  
The Security Task Setup window may be used to grant or restrict access to the Negative Deductions 

Enhancement windows. To open the window, select the Microsoft Dynamics GP menu, select Tools, select 

Setup, select System, select Security Tasks and enter the system password. 

1. Select the appropriate Task items. To identify the appropriate task item complete the steps below: 

• Open the User Security Setup window (Microsoft Dynamics GP > Tools > Setup > User 
Security), select the appropriate user and make a note of the Security Role ID assigned to the 
user. 

• Open the Security Role Setup window (Microsoft Dynamics GP > Tools > Setup > Security 
Roles), select the Role ID that has been assigned to the user and make note of the Security 
Task ID assigned to the Role. Use this Task ID to grant security to the Negative Deductions 
Enhancement. 
NOTE: Negative Deductions Enhancement uses two tasks;  NDE_ADMN_001*  and 
NDE_TRX_001*   

2. Select Negative Deductions Enhancement for the Product. 

3. Select Windows for the Type and select 3rd Party for the Series. 

4. Use the Access List to grant or restrict access to individual items. 

 To grant or restrict access to an item for this Task ID, click the checkbox to mark or unmark 
the item. 

 Click the Mark All button to grant access to all items in the list or click the Unmark All button 
to restrict access to all items in the list. 

5. Click File > Print to print the Security Task Setup Report for the selected Task ID. 

6. Choose OK to save your changes. 

 

Negative Deductions Enhancement > Windows > 3rd Party > Access List 

 APR Main Menu 

 Convert Deduction 

 Deduction Mapping Setup 

 Negative Deduction 

 Negative Deduction Setup 

Negative Deductions Enhancement > Reports > 3rd Party > Access List 

 Negative Deduction Build Report 

 Negative Deduction Mapping Report 

Security Tasks 
Two tasks are created by Negative Deductions Enhancement; The NDE_ADMN_001* task and the 

NDE_TRX_001* task. 

NDE_ADMN_001* is used for setup level activity 

The following windows will be assigned to the NDE_ADMN_001* task: 
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 Deduction Mapping Setup 

 Negative Deduction Setup 

The following reports will be assigned to the NDE_ADMN_001* task: 

 Negative Deduction Mapping Report 

 

NDE_TRX_001* is used for transactional level activity and data entry 

The following windows will be assigned to the NDE_TRX_001* task: 

 Convert Deduction 

 Negative Deduction 

The following reports will be assigned to the NDE_TRX_001* task: 

 Negative Deduction Build Report 
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Setup Windows 
Negative Deduction Setup 
Microsoft Dynamics GP > Tools > Setup > Payroll> Negative Deduction Setup 

Use the Negative Deduction Setup window to specify settings for adjustment posting and deduction-to-pay 

code mapping. 

To open the Negative Deduction Setup window, within the Navigation Pane select HR & Payroll. In the Content 

Pane, select Setup. Under the heading Payroll, select Negative Deduction Setup 

 

Figure 1.1 

Allow pay code mapping override checkbox – select to enable the user to modify the Map to Pay Code field in 

the Convert Deduction window. 

Auto Post Adjustments – select to have the system automatically post the reversing adjustments for converted 

deductions after payroll is finished the normal posting procedure. 

 

NOTE: The system will use the Posting Settings selections when determining 

whether to Post to or Post Through the General Ledger. 
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Deduction Mapping Setup 
Microsoft Dynamics GP > Tools > Setup > Payroll> Deduction Mapping Setup 

Use the Deduction Mapping Setup window to set up a mapping record which ties one or more deductions to a 

pay code. During the negative deduction conversion process the deductions will be changed to a pay code 

transaction using the pay code specified. Later during the manual adjustment process the distributions are 

reversed and cleared so the negative deduction is properly recorded.   

To open the Deduction Mapping Setup window, within the Navigation Pane select HR & Payroll. In the Content 

Pane, select Setup. Under the heading Payroll, select Deduction Mapping Setup 

 

Figure 1.2 

Pay Code lookup – enter a pay code or select one using the lookup. This code will be the one to appear on the 

check/earnings statement in the event a user elects to convert a negative deduction mapped to it. The lookup 

field will only display pay codes of type “business expense” which are not marked “Report as Wages”.  Even 

though the report as wages is unmarked the “Subject to Taxes” checkbox will affect the taxability of a pay 

code, and deductions that are sheltered from specific taxes will affect the “Wages” (Report As Wages amount 

field) once the manual check is posted. 

Available Deduction – select one or more deductions to map to the codes listed in the Pay Code field above. 

When creating a negative deduction and choosing to convert it, the system will convert to the pay code 

specified. 
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Transaction windows 
Convert Deduction 
Microsoft Dynamics GP > Transactions > Payroll > Transaction Entry> [Tab off row containing negative 

deduction] 

Microsoft Dynamics GP > Transactions > Payroll > Transaction Entry> [Additional Menu] > Deduction 

Conversion 

Use the Convert Deduction window to select whether a negative deduction should be converted or not during 

payroll processing.  Additionally you can specify which pay code to use for the deduction during the conversion.   

To open the Convert Deduction window, within the Navigation Pane select HR & Payroll. In the Content Pane, 

select Transaction. Under the heading “Payroll”, select Transaction Entry. You must have a negative deduction 

transaction selected or created to open this window 

 

Figure 2.1 

Convert Negative Deduction – The checkbox is enabled by default.  Therefore the system will convert the 

negative deduction being edited to the pay code listed in the field below.  You can unmark this checkbox if you 

wish to process the deduction code without benefit of the conversion. 

NOTE: Unchecking the “Convert Negative Deduction” checkbox may lead to 

unexpected processing results for the deduction during payroll processing. This 

is especially true of negative deductions that are not both fixed amount 

transaction required. 
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Map to Pay Code – enter a pay code or use the lookup to select a code.  The pay code should be assigned to the 

employee whose negative deduction transaction you are editing.  This field may not be available if the 

Negative Deduction Setup option is not marked to “Allow pay code mapping override”. Only pay codes of type 

“Business Expense” are allowed. 

 

Negative Deduction 
Microsoft Dynamics GP > Transactions > Payroll > Batches > [Additional Menu] > Negative Batch 

Use the Negative Deduction window to select whether a batch is designated as “negative”. Doing so will cause 

the system to attempt to convert all negative deductions in the batch during payroll processing. These settings 

can be overridden on a per transaction basis if desired by: 

 recalling the batch 

 selecting the transaction 

 navigating to the Convert Deduction window from additional menu 

 unmarking the Convert Negative Deduction checkbox  

To open the Negative Deduction window, within the Navigation Pane select HR & Payroll. In the Content Pane, 

select Transaction. Under the heading “Payroll”, select Batches. Enter or select a batch ID and then under the 

Additional menu select “Negative Deduction”. 

 

Figure 2.2 

Negative Batch – select the Negative Batch checkbox to mark the batch as a negative batch. A negative batch 

is processed differently than a normal batch during payroll processing, in that, it attempts to convert all 

negative deductions contained in the batch during the build process.  The system will use existing Deduction 

Mappings settings assuming that the user has not overridden the defaults in Payroll Transaction Entry. The 

conversion happens unless a transaction has been specifically selected to not convert.  
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Process 
To process a negative deduction using Negative Deductions Enhancement, you must follow a series of steps to 

either create a negative deduction transaction in Payroll transaction Entry, or import one or more negative 

deduction transactions into a batch.  Once created, modified or imported, these transactions will be processed 

by the system in one of two ways depending on setup options and the transactions themselves:  

1) The system will process a negative deduction according to current functionality (eg... a transaction required, 

negative, fixed amount deduction in payroll transaction entry)  

2) The system will convert the negative deduction to a pay code transaction for the pay check and then create 

a manual check adjustment to update the pay code and deduction balances in history with the appropriate 

negative amounts.   

 

Payroll Transaction Entry 
In most scenarios, negative deductions are created in a normal batch and may be mixed with other types of 

transactions. They can however, be imported (see Negative Batches and Imported Transactions below) 

Regardless of batch type, a negative deduction transaction begins in transaction entry in the same way other 

transactions are entered.  

 

Figure 3.1 

A deduction transaction is entered and the user moves to the code field.  At this point the user must enter the 

deduction code which will end up being a negative deduction.  After entering the deduction code and tabbing 

off the field the system will prompt whether this deduction is to become a negative deduction. 
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Figure 3.2 

After selecting continue and entering an amount the system will automatically ensure that the deduction is 

displayed as an amount and that the number is  negative. Thus, if the user selects to create a negative 

deduction and then fails to input a negative amount, the system will automatically adjust the amount to be 

negative when leaving the field.   
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Now that the deduction has been created and the user moves off the row the system may prompt yet again for 

further information as depicted in figure 3.3  

 

Figure 3.3 

 

The user has entered the negative deduction in transaction entry and is now prompted to either convert the 

deduction.  If the user accepts the defaults the system will convert this deduction during the payroll build 

process resulting in a pay code transaction for $20 for pay code EXAT.  If the user decides not to convert the 

deduction the system will attempt to process the MED deduction as a negative amount.  Depending on the 

deduction type this may process with unexpected results.  It is recommended to accept the defaults for the 

decision to convert.    Notice that you can alter which pay code is used for the conversion if the “Allow Pay 

Code Override” option is checked in Negative Deduction setup. 

 

NOTE: Due to existing Dynamic GP functionality, the Code lookup will only 

display deduction codes which have transaction required selected. You will need 

to manually enter the desired code for deductions that are not marked 

transaction required.  Zoom to Employee Deduction Maintenance for a quick way 

to obtain the codes assigned to the employee.  

 

The next step is to process payroll by creating a build which will contain the batches containing negative 

deduction transactions. The Negative Deduction report, which displays during the build process, as well as 

other payroll transaction reports are detailed in the “Reports” section below.   Once these have been viewed 

and the build is completed, the system will process payroll normally until post.  At that time the system will 

create manual adjustments for the converted negative deduction transactions.  



27 

 

Negative Batches and Imported Transactions 
When importing transactions into a batch it is advisable to mark the batch as negative so the system will 

attempt to process the negative deductions using the pay code conversion method. Recall that the conversion 

will utilize the pay codes selected in Deduction Mapping Setup. This is best for large numbers of transactions 

where you do not want to modify each transaction individually.  

To use a negative batch you must first designate a normal batch as negative.  This can be done from Payroll 

Batch Entry by recalling a batch and then choosing “Negative Batch” from the additional menu. 

 

Figure 4.1 

This will bring up the Negative Deduction window where the user can select to mark a batch as Negative. 

 

Figure 4.2 

Checks and Earnings Statements 
For negative deductions that are not already supported by Microsoft Dynamics GP, the system creates pay 

code transactions as part of the conversion process.  The mapped pay code can appear on a check 

independently of any wage amount.  Thus, the MED deduction illustrated below represents a deduction that 
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was not transaction required and could not be processed as a percent of gross wage on a check with no gross 

wages.  Therefore, we instead see its mapped pay code of EXAT. 

 

Figure 5.1 
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The check (in this case an earnings statement) itself then contains no wages but the negative deduction is 

present as a positive amount for a business expense. Note that taxes and deductions are still taken from the 

check resulting in a net amount of $21.41.   Deduction Setup, Deduction Maintenance, and the choice of a 

“business expense” pay type for the converted negative deduction can all influence how a check will calculate.  

For a brief list of best practices see the Tips/Hints section. 

 

Figure 5.2 
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Manual Adjustments 
Thus far the employee has received the reimbursement for an over-withheld medical deduction in the form of 

a negative deduction, which was converted and appeared as a pay code on the earnings statement. Now that 

the reimbursement has been processed and delivered, the system must make some adjustments to bring the 

balances back in line. Specifically, the system needs to show a negative amount for the deduction code to 

offset the over withheld amount from before.  It also needs to show a negative amount for the pay code it 

used in the conversion transaction to offset the positive amount that was used during payroll processing. To 

accomplish this, the system creates a manual adjustment with two transactions. 

 

  

Figure 6.1 

The adjustment is contained in a batch which is prefixed NDMC and has the date of creation with an 

increment factor appended to the end. Any other batches created on this date will be incremented using the 

suffix number beginning with “001”. 

NOTE: The batch will contain an adjustment for each employee that had a 

negative deduction transaction in the pay run. Posting adjustments for large 

numbers of employees can be done automatically if edit checks are not needed. 

Mark “Auto Post Adjustments” in Negative Deduction Setup.    

The first transaction to be reversed is the MED deduction, which in this case, needs to be a negative amount.  

Recall that during the build process, this code was converted to a pay code and an amount was never 
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processed for it to offset the over-withholding that occurred during a previous pay run. The system now 

accounts for this and creates the negative amount for MED. 

 

Figure 6.2 

The second transaction included is the adjustment is for the pay code that was using during the conversion. 

The system creates a negative amount for the pay code “EXAT” to offset the amount used on the earnings 

statement.  

 

Figure 6.3 
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Reports 
Negative Deduction Report 
This report displays just prior to the build report and displays all negative deductions contained within the 

build.  It is sorted by Employee then Batch ID. 

   

 

Figure 7.1 

Each negative deduction transaction is listed with the following information 

o Batch ID 

o Trx # 

o Original Deduction Code 

o Converted to Code 

o Amount 

If a negative deduction cannot be converted then the system will display a warning underneath the 

transaction (see Figure 7.1).  In some cases a negative deduction transaction will be listed without a warning 

but still have the “converted to” column missing a code.  This occurs when a deduction was purposely marked 

to not convert and was allowed to proceed through payroll processing anyway.  
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Deduction Mapping Report 
This report is invoked from the Print button on the Deduction Mapping Setup window and displays all pay 

codes which have deductions mapped to them. The report is sorted by pay code and then deduction code. 

  

 

 

Figure 7.2 

 

 

Each pay code and corresponding description lists the following 

o Deduction Code 

o Description 
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Payroll Transaction Edit List Report 
This report has been modified to allow the system to display converted negative deductions, with the amount 

in parenthesis. Security setting will not need to be modified to view this report. 

 

 

 

Figure 8.1 

 

Payroll Transaction Audit List Report 
This report has been modified to allow the system to display converted negative deductions, with the amount 

in parenthesis. Security setting will not need to be modified to view this report. 

 

 

Figure 8.2 
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Hints, Essentials and FAQs 
Converting a Deduction 
Deductions that are fixed amount and transaction required can be entered as a negative deduction amount 

using existing Microsoft Dynamics GP core functionality. Entering negative deductions of other types (“special 

negative deductions”) relies upon Negative Deductions Enhancement to process a conversion. As such, the 

Convert Negative Deduction checkbox is checked by default.  See below: 

 

 

However, the system does support turning off the conversion process if you wish to process a “special negative 

deduction” without benefit of a conversion.  ***Please note that this may generate unexpected results as the 

core Microsoft Dynamics GP environment does not support this natively. It is advisable to consult all build and 

calculate reports before attempting this in a live environment.  

Benefits based on deductions 
Negative Deductions Enhancement does not make adjustments to benefits.   
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Activation Manager Messages 
Activation Failed: Trial invalid or trial period expired 
Situation: The trial period has expired for the product.  

Solution: Contact sales@integrity-data.com and request additional trial period or purchase the product.  

Activation Failed: Site name does not match this installation 
Situation:  The site name does not match the token which was issued. 

Solution: Send support@integrity-data.com a screenshot of the Activation Manager window with the error 

message displayed so the token can be updated with the correct site name. 

Activation Failed: Product Name does not match this installation 
Situation: The product name does not match the token which was issued for a product. 

Solution: Send support@integrity-data.com a screenshot of the Activation Manager window with the error 

message displayed so the token can be updated with the correct site name. 

Trial period for Negative Payroll Transactions has expired 
Situation: The trial period has expired for the product. 

Solution: Contact sales@integrity-data.com and request additional trial period or purchase the product. 

Employees Allowed has been exceeded 
Situation: The current employee count has exceeded the employees allowed. 

Solution: Contact sales@integrity-data.com to upgrade to the next tier. 

Activation Failed: Unable to contact web service. Activate manually or revert to previous 

product dictionary 
Situation: The system could not make a connection to the web service. 

Solution: Contact support@integrity-data.com for assistance. 

Activation Failed: Product has been deactivated 
Situation: The product has been deactivated. 

Solution: Contact support@integrity-data.com for assistance. 

Upgrade Failed: Enhancement Plan period expired.  Renew Enhancement Plan or revert to 

previous product version. 
Situation: User attempted to upgrade a product when their enhancement plan was expired. 

Solution: Contact sales@integrity-data.com to renew the enhancement plan. 

 

mailto:sales@integrity-data.com
mailto:support@integrity-data.com
mailto:support@integrity-data.com
mailto:sales@integrity-data.com
mailto:sales@integrity-data.com
mailto:support@integrity-data.com
mailto:support@integrity-data.com
mailto:sales@integrity-data.com
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Negative Deductions Enhancement Messages  
“Code for Negative Deduction not mapped to a Pay Code. Transaction not converted” 
Situation: Warning appears on the Negative Deduction Report 

Solution: Edit the transaction if necessary or allow the negative deduction to continue without conversion 

 

“Mapped Code for Negative Deduction not assigned to employee. Transaction not converted” 
Situation: Warning appears on the Negative Deduction Report 

Solution: Edit the transaction if necessary or allow the negative deduction to continue without conversion 
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Deactivate Product 
There are three ways to deactivate the Negative Deductions Enhancement; disable, inactive or uninstall. 

Disable 
To disable Negative Deductions Enhancement without having to exit Microsoft Dynamics GP, open the 

Customization Status window. To open this window, select the Microsoft Dynamics GP menu, point to Tools, 

select Customize and then click Customization Status. Select the product from the list and click Disable. The 

product can be enabled by closing and reopening Microsoft Dynamics GP. 

Inactivate 

Negative Deductions Enhancement can be inactivated by company, open the Activation Manager window and 

unmark the company checkbox. 

Uninstall 

If Negative Deductions Enhancement needs to be uninstalled complete these steps on the server and the client 

where Negative Deductions Enhancement has been installed. 

1. Remove the NDE7224.DIC file from the Runtime Directory  

Default location is C:\Program Files\Microsoft Dynamics\GP 2015 or C:\Program Files\Microsoft 

Dynamics\GP 2016 

2. Make a copy of the Dynamics.set file 

3. Open the Dynamics.set file 

a. Decrease the top number by one: 

For example, if the top number is 21 change it to 20 

b. Remove the following lines from the Dynamics.set file: 

7224 

Negative Deductions Enhancement 

:C:Program Files/Microsoft Dynamics/GP/NDE7224.DIC 

:C:Program Files/Microsoft Dynamics/GP/Data/NDE7224F.DIC 

:C:Program Files/Microsoft Dynamics/GP/Data/NDE7224R.DIC 

4. Save the Dynamics.set file 

5. Launch Microsoft Dynamics GP and login as the ‘system administrator’ 
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Uninstall Activation Manager 
Activation Manager will manage activation for all Integrity Data Products.  If you are uninstalling all Integrity 

Data products, you need to remove the Activation components. 

IMPORTANT: If you uninstall one product but have other Integrity Data products do not uninstall the 

Activation Manager components. 

1. Make a copy of the Dynamics.set file  

2. Open the Dynamics.set file 

a. Decrease the top number by one: 

For example, if the top number is 21 change it to 20 

b. Remove the following lines from the Dynamics.set file: 

 

6537 

Integrity Data Activation 

:C:Program Files (x86)/Microsoft Dynamics/GP2013/IDA6537.DIC 

:C:Program Files (x86)/Microsoft Dynamics/GP2013/Data/IDA6537F.DIC 

:C:Program Files (x86)/Microsoft Dynamics/GP2013/Data/IDA6537R.DIC 

1. Save the Dynamics.set file 

Make a copy of the Dynamics.exe.config file.   

3. Edit Dynamics.exe.config and find the line(s) beginning with: 
 

<addin name=”IDKeyManagerAddin” 

 

4. Remove the lines from both the <Dynamics> and <DynamicsGPWeb> sections. 
 

5. Save the Dynamics.exe.config file 
 

6. Launch Microsoft Dynamics GP and login as the ‘system administrator’ 
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Contact Information 
Get quick answers to your questions 

Browse our convenient Knowledge Base for up-to-date answers to the most common questions. For additional 

questions, please contact your authorized Value Added Reseller (VAR) for support on this product (if you have 

one) or contact Integrity Data by emailing support@integrity-data.com or calling 888.786.6162. 

If you have registered your product, Technical Customer Service is available for any customers with a current 

Enhancement Plan or subscription. Please have your Company or Site Name available. Your first line of support 

should always be your VAR (if you have one). 

Join our User Groups 

We have an HR and payroll focused one and an ACA one – email lbelley@integrity-data.com to join! 

Rate us and our products 

Are you pleased with your experience with us and our products? Provide a quote and get a gift card! Fill out the 

form on our contact page and leave your quote in the comment section. 

Suggest new features or improvements 

User input into improving this product and constructive feedback are appreciated. Please e-mail Tom, our 

Product Manager, at tfranz@integrity-data.com. As always, technical ideas and user input are highly 

encouraged. At Integrity Data, we want to hear your input, so drop us a line! 

Browse our solutions 

The Integrity Data website is a great place to get additional information on products and services. The 

following information is available on our website: 

 Integrity Data’s HR & Payroll software pages include Demos, Features and Benefits, and ROI 

Calculators 

 Visit our Services page to learn more about our additional customization services 

If you would like to discuss your needs with a Sales Account Executive, please call 888.786.6162 or e-mail 

sales@integrity-data.com. 

 

http://www.integrity-data.com/knowledge-base
mailto:support@integrity-data.com
mailto:lbelley@integrity-data.com
http://www.integrity-data.com/contact
mailto:tfranz@integrity-data.com
http://www.integrity-data.com/software
http://www.integrity-data.com/services
mailto:sales@integrity-data.com

